
INTRODUCTION TO ORCAD 

Hands-On Workshop  

Embedded Solutions 

Quick Reference Guide 





CONTENTS 
• Capture shortcut keys and toolbars 
• Layout shortcut keys and toolbars 
• Chart of current capabilities of trace widths 
• Tips For Successful Schematics and Layout 
• Additional sources of OrCAD information 

Introduction To OrCAD 
Quick  Reference and 
Supplementary Material 

Copyright © 2002 Embedded Solutions. All rights reserved. 

Embedded Solutions 



Copyright © 2002 Embedded Solutions. All rights reserved. 
 
OrCAD®, OrCAD Capture®, OrCAD Layout® and PSpice® are registered trademarks of 
OrCAD Corporation. 
 
All other brands and product names mentioned herein are used for identification purposes 
only, and are trademarks or registered trademarks of their respective holders. 
 
EMBEDDED SOLUTIONS MAKES NO WARRANTY OF ANY KIND WITH REGARD TO 
THIS MATERIAL INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
 
EMBEDDED SOLUTIONS SHALL NOT BE LIABLE FOR ANY INCIDENTAL, INDIRECT, 
SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING BUT NOT 
LIMITED TO LIST PROFITS) ARISING OUT OF OR RELATED TO THIS PUBLICATION 
OR THE INFORMATION CONTAINED IN IT, EVEN IF EMBEDDED SOLUTIONS HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
 
 

Contractor/manufacturer is: 
Kalen Brunham 

Embedded Solutions 
162-2025 Corydon Av. 

Winnipeg, Manitoba 
R3P 0N5 CANADA 

 
General email: info@embeddedsolutions.net 

Web site: www.embeddedsolutions.net/training.html 
 
 
 
 

This is an unpublished work of Embedded Solutions. 



- 1 - 

Useful OrCAD Capture Shortcut Keys 
See the Shortcuts topic in Capture online help for a complete list of  shortcut keys. 

Key  Mode or user interface item  Function or menu command 
CTRL+A  View menu  Select All 

SHIFT+A  View menu  Ascend Hierarchy 

B , SHIFT+B Place menu  Bus 

CTRL+B  View menu  Previous Part 

CTRL+C  Edit menu  Copy 

SHIFT+D  View menu  Descend Hierarchy 

E , SHIFT+E Place menu  Bus Entry 

ESC  Schematic page editor and part editor  End Mode, Unselect any selected object 

CTRL+E  Edit menu  Properties 

F, SHIFT+F  Schematic page editor  Place Power 

CTRL+F  Edit menu  Find 

G, SHIFT+G  Schematic page editor  Place Ground 

H  Mirror (on the Edit menu)  Horizontally 

I  Zoom (on the View menu)  Zoom In 

J , SHIFT+J Place menu  Junction 

N , SHIFT+N Place menu  Net Alias 

CTRL+N  View menu  Next Part 

O  Zoom (on the View menu)  Zoom Out 

P , SHIFT+P Place menu  Part 

CTRL+P  File menu  Print 

R , CTRL+R Edit menu  Rotate 

CTRL+S  File menu  Save 

T , SHIFT+T Place menu  Text 

CTRL+T  Schematic page editor and part editor  Toggle snap to grid on and off 

CTRL+U  Edit menu  Ungroup 

V  Mirror (on the Edit menu)  Vertically 

CTRL+V  Edit menu  Paste 

W , SHIFT+W Place menu  Wire 

CTRL+X  Edit menu  Cut 

SHIFT+X  Schematic page editor  No Connect placement mode 

Y , SHIFT+Y Place menu  Polyline 

CTRL+Z  Edit menu  Undo 
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OrCAD Capture Main Toolbar 

Tool Name Description 

 New document Creates a new document based on the active document. 

 Open document Opens an existing document based on the active document. 

 Save document Saves the active schematic page or part. 

 Print Prints the active schematic page or part. 

 Cut to clipboard Removes the selected object and places it on the Clipboard. 

 Copy to clipboard Copies the selected object to the Clipboard. 

 Past from clipboard Pastes the contents of the Clipboard at the cursor. 

 Undo Undoes the last command performed. 

 Redo Redoes the last command performed. 

 Most recently used Displays the most recently placed part name in the drop-down list. 

 Zoom in Zooms in to present a closer, enlarged view 

 Zoon out Zooms out to present more of your document. 

 Zoom to region Specifies an area of the schematic page or part to enlarge to fill the 
entire window. 

 Zoom to all Views the entire document. 

 Annotate Assigns part references to parts on the selected schematic pages. 

 Back annotate Back annotates the selected schematic pages. 

 Design rules check Checks for design rules violations in the selected schematic pages. 

 Create netlist Creates a netlist from the selected design. 

 Cross reference Creates a cross reference report of the selected schematic pages. 

 Bill of materials Creates a bill of materials report from the selected schematic pages. 

 Snap to grid Turns snap to grid on and off. 

 Project manager Displays a project manager window for the active document, 
providing an overview of the project contents. 
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OrCAD Capture Schematic Page Editor Tool Palette 

Tool Name Description 

 Selection Selects objects. 

 Part Selects parts from a library for placement. 

 Wire Draws wires. SHIFT allows any angle drawing. 

 Net alias Places aliases on wires and buses. 

 Bus Draws buses. SHIFT allows any angle drawing. 

 Junction Places or deletes junctions. 

 Bus entry Draws bus entries. 

 Power Places power symbols. 

 Ground Places ground symbols. 

 Hierarchical block Places hierarchical blocks. 

 Hierarchical port Places hierarchical ports on schematic pages. 

 Hierarchical pin Places hierarchical pins in the selected hierarchical block. 

 Off-page connector Places off-page connectors. 

 No connect Places no-connect symbols on pins. 

 Line Draws lines. 

 Polyline Draws polylines. SHIFT allows any angle drawing. 

 Rectangle Draws rectangles. SHIFT constrains the shape to a square. 

 Ellipse Draws ellipses. SHIFT constrains the shape to a circle. 

 Arc Draws arcs. 

 Text Places text. 
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OrCAD Capture Part Editor Tool Palette 

Tool Name Description 

 Selection Selects objects. 

 IEEE symbol Places IEEE symbols on a part. 

 Pin Places pins on a part. 

 Pin array Places multiple pins on a part. 

 Line Draws lines. 

 Polyline Draws polylines. SHIFT allows any angle drawing. 

 Rectangle Draws rectangles. SHIFT constrains the shape to a square. 

 Ellipse Draws ellipses. SHIFT constrains the shape to a circle. 

 Arc Draws arcs. 

 Text Places text. 
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Useful OrCAD Layout Shortcut keys 
See the Shortcuts topic in Layout online help for a complete list of  shortcut keys. 

Key  Mode or user interface item  Function or menu command 
A  With an obstacle selected  Arc 

B  Zoom  Zoom DRC/Route Box 

SHIFT+C  Spreadsheet  Components 

C  Zoom  Zoom Center 

D  With a track selected  Unroute 

ALT+D  With a track selected  Unroute Net 

E  With a track selected  Add Free Via 

CTRL+E , ENTER  Properties 

F  With a track or obstacle selected  Finish 

CTRL+F , TAB  Find/Goto 

G  With a track selected  Unroute Segment 

CTRL+G   System Settings 

SHIFT+G  Spreadsheet  Route Spacing 

H  Highlight Net 

I  Zoom  Zoom In 

CTRL+I   Library manager 

J  With a component selected  Shove 

CTRL+J  With components selected  Adjust  

K  With components selected  Make cluster 

CTRL+K  With a component cluster selected  Break cluster 

L  With a component or track selected  Lock 

CTRL+L  With a track selected  Unlock 

M  With a component, track, or pin selected  Minimize Connections 

CTRL+M  With a track, obstacle, or text selected  Mirror 

N            With a component, track, or error selected Select Next 

O Zoom  Zoom Out 

P  With a track selected  Add Test Point 

CTRL+P   Print/Plot 

Q   Query window 

CTRL+Q  With a component selected  Quick Place 

R , CTRL+R With a component, track, obstacle, pin, or 
text selected  

Rotate 
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Useful OrCAD Layout Shortcut keys (continued) 
 

Key  Mode or user interface item  Function or menu command 
S            With a track or obstacle selected              Segment 

ALT+S     Select Any  

CTRL+S     Save file 

T  With a component selected  Opposite layer 

CTRL+T  With a track selected  Tack 

U, CTRL+Z   Undo 

V  With a track selected  Add Via 

CTRL+V   New or Paste 

W  With a track selected  Change Width 

CTRL+W  With components, gates, or pins selected  Swap 

X  With a track or obstacle selected  Exchange Ends 

CTRL+X   Delete 

Y  With a track or obstacle selected  Any Angle Corners 

Z  Zoom  Zoom Area 

ALT+Z  Zoom  Zoom Previous 

ESC   End Command 

F1   Help Topics 

F3   Component Selection Criteria  

F5   Redraw 

F7   Online DRC 

SHIFT+F4   Tile windows 

SHIFT+F5   Cascade windows 

<  With a track selected  Decrease width 

>  With a track selected  Increase width 

CTRL+<  In the query window  Query previous object 

CTRL+>  In the query window  Query next object 

PERIOD   High Contrast 

DASH   Visible <> Invisible 

BACKSPACE   Clear Screen 

HOME   Redraw 

SHIFT+HOME  Zoom  Zoom All (Fit) 

DELETE   Delete 
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OrCAD Layout Main Toolbar 

Tool Name Description 

 Open Opens an existing board. 

 Save Saves an existing board. 

 Library manager Opens the library manager. 

 Delete Deletes whatever you have selected. 

 Find Displays the Find Coordinate or Reference Designator dialog box, 
which you use to search for specific coordinates or reference 
designators. 

 Edit Displays an appropriate editing dialog box, depending on what you 
have selected. 

 Spreadsheet Displays a list of the available spreadsheets. 

 Zoom in Magnifies selected areas of the board. 

 Zoom out De-magnifies selected areas of the board. 

 Zoom all Zooms so that you can see the entire board. 

 Query Displays the query window, which lists an object�s properties. 

 Component Enables you to select, add, move, edit, or delete components. 

 Pin Enables you to select, add, move, edit, or delete pins. 

 Obstacle Enables you to select, add, move, edit, or delete obstacles. 

 Text Enables you to select, add, move, edit, or delete text. 

 Connection Enables you to select, add, combine, or delete net connections. 

 Error Enables you to select error markers related to spacing and design 
rule violations. 
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OrCAD Layout Main Toolbar (continued) 

Tool Name Description 

 Color Color Displays the Color spreadsheet, within which you change the 
color of layers or objects, or their visibility (visible or invisible). 

 Online DRC Enables online design rule checking. 

 Reconnect Enables reconnect mode, which you use to show or hide routes and 
connections. Note that reconnect mode should only be used during 
component placement, before any routing is done. 

 Auto path route Enables auto path route mode, which you use to route and place vias 
interactively using the shove algorithm. 

 Shove track Enables shove track mode, which you use to route manually using 
the shove algorithm. 

 Edit segment Enables edit segment mode, which you use to select existing tracks 
and change their positions, while Layout automatically adjusts the 
angles and sizes of adjacent segments to maintain connectivity. 

 Add/edit route Enables add/edit route mode, which you use to route manually 
without using the shove algorithm. 

 Refresh all Minimizes connections, repours copper, and recalculates board 
statistics. 

 Design rule check Runs a design rule check using the options selected in the Check 
Design Rules dialog box (accessed by choosing Design Rule Check 
from the Auto menu). 
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Tips for Successful Schematics and PCB Layout 

1. Try and only use B size sheets when drawing schematics. This makes it much 
easier to print and troubleshoot the design. 

2. When drawing circuitry, inputs tend to be on the left, outputs tend to be on the right. 
Using a uniform flow will allow other to easily read your design. 

3. All signals going to connectors should be clearly labeled. This will help in 
debugging your design. 

4. Important internal signals should be clearly labeled. 

5. Indicate which page off-page connections go to. 

6. Give labeled nets meaningful names. However, don�t use characters such as  
! @ # $ % ^ & * _ as these characters may be interpreted as control characters. 

7. Do not draw four way junctions. These can be mistaken for crossovers. 

8. Verify pinout of schematic symbols for all new parts that have been created. 

9. Add schematic notes where appropriate. Notes identifying high speed nets and high 
current nets will ease the PCB layout and troubleshooting. 

10.Do not change part references or net names on new board revisions. Changing 
these can result in the layout being completely started over again. 

 

These tips are intended to help you draw schematics, ease the PCB layout for you or your PCB 
design team, and for troubleshooting your circuitry. These tips can be applied to any vendor�s PCB 
design package. 
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Additional Sources for OrCAD Information 

• OrCAD Capture Users Guide 
           (http://www.orcad.com/files/pdf/r92manuals/capug.pdf) 
 
• OrCAD Capture Quick Reference Guide 
           (http://www.orcad.com/files/pdf/r92manuals/capqrc.pdf) 
 
• OrCAD Layout Users Guide 
           (http://www.orcad.com/files/pdf/r92manuals/layug.pdf) 
 
• OrCAD Layout Quick Reference Guide 
           (http://www.orcad.com/files/pdf/r92manuals/layqrc.pdf) 
 
• OrCAD Layout Getting Started Guide 
           (http://www.orcad.com/files/pdf/r92manuals/layqs.pdf) 
 
• OrCAD Technical Library 
           (http://www.orcad.com/Technical/Library/Library.asp) 

• Knowledge base 
• Technical articles 
• OrCAD Capture Student Edition 
 

• OrCAD Help 




